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Vox Maris
GMDSS Simulator

Vox Maris is a technical training tool. It is a PC-based simulator to train sea-faring
people in the use of GMDSS communications equipment, within a controlled and
safe environment. 

Vox Maris simulates the functionality of marine radio and satellite communications
equipment according to the operational norms determined by The International
Telecommunication Union. It also emulates real conditions of the marine radio
communications such as noises, attenuation by distance in terrestrial and
ionospheric propagation, and different types of sound effects from communication.
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1 Overview

Introduction 

The  Inmarsat  C  is  a  via  satellite  system  that  provides  worldwide  Telex  and  data
transmission / reception of written information to owners of Inmarsat C transceivers
or a terrestrial Telex network. 

Inmarsat C  fulfills  the  majority  of  the  communications  requirements  of  the  GMDSS.
Also,  the  system enables  to  send e-mail  using internet.  Thus,  Inmarsat  C  is  a  very
flexible  system that  can  easily  handle  as  much  personal,  commercial  and  operative
messages as communications relative to distress and security.

Communication  mode  is  store-and-forward  Telex:  A  MES  (Mobile  Earth  Station)
transmits a message into packed data to a LES (Land Earth Station). The LES stores
and remakes  the  packets,  and  finally  transmits  them to  the  designated  party  using
national  and  international  communication  networks.  In  the  opposite  direction,
messages can be sent to a Inmarsat C station or group of stations.

Inmarsat  C  provides  the  following  satellite  service  for  digital  interchange  of  data
through simple and economic portable terminals:

· E-mail and messaging 

· Fax and Telex 

· SMS text 

· Remote monitoring / Tracking 

· Chart and weather updates 

· Maritime safety information 

· Messages GMDSS for aid and security

· EGC messages: SafetyNET and FleetNET 

Inmarsat-C  terminals  can  receive  multiple-address  messages  known  as  Enhanced
Group Calls (EGC), and a special header is added to the text to indicate the group of
mobiles  or  the  geographical  area to  which  the  message  is  to  be  sent.  EGCs  can  be
transmitted in most languages or alphabets. There are two main types of EGC: 

SafetyNET provides an efficient and low-cost means of transmitting maritime safety
information  to  vessels  at  sea  and  is  used  by  hydrographic,  search  and  rescue,
meteorological and coastguard co-ordination authorities. Messages can be directed to
mobiles in or approaching specific regions such as one of the IMO NAV/MET areas or
the sea area around a search and rescue incident. 

FleetNET allows commercial information to be sent to a virtually unlimited number of
predesignated  mobile  terminals  simultaneously.  It  is  suitable  for  use  by  services
specializing  in  the  distribution  of  news,  stock  exchange  reports,  sporting  results,
weather analyses, and road/port information. 

Maritime Inmarsat-C terminals are equipped with a distress-alerting feature which,
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in  the  event  of  an  emergency automatically  generates  and  sends a  priority  distress
alert,  incorporating  position  and  other  information,  to  a  land-based  rescue
co-ordination center (RCC)

Inmarsat Coverage Map

 

There  are  four  Ocean  Regions  covering  the  world  each  with  its  own  operational
satellite.

Atlantic Ocean Region East (AOR-E), Inmarsat-3 F4 satellite at 54,0º W 
Atlantic Ocean Region West (AOR-W), Inmarsat-3 F2 satellite at 15,5º W 
Indian Ocean Region (IOR), Inmarsat-3 F3 satellite at 178,0º E
Pacific Ocean Region (POR), Inmarsat-3 F1 satellite at 64,0º E

The  Inmarsat  C  system  consists  of  the  Operation  Control  Center  (OCC),  Satellite
Control Centers (SCC), four Network Coordination Stations (NCS) (one for each ocean
region), Land Earth Stations (LES) and Mobile Earth Stations (MES). The OCC, located
at  Inmarsat's  London  headquarters,  coordinates  a  wide  range  of  activities  in  the
Inmarsat system, including commissioning of mobile earth stations.

Transmission  and  reception  of  signals  are  co-ordinated  by  network  co-ordination
stations  (NCS).  Each  NCS  monitors  the  flow  of  communications  traffic  through  its
satellite  to  ensure  that  calls  are  correctly  set-up  and  that  all  LESs  are  working
correctly.
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Types of MES

There are three types of MES: class 1, class 2 and class 3.  The device simulated by
Vox Maris is a class 2 MES. 

Class 1: 1) Transmits messages to LES
2) Receives messages from LES

Class 2: 1) The functions of  class  1 plus  operation  as  an  EGC receiver  when not
transmitting or receiving.

2) EGC-only receiver

Class 3: The  function  of  class  1  plus  simultaneous  operation  as  an  EGC-only
receiver.



Operational overview

Chapter II
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2 Operational overview

 

The terminal  unit  is the main component  of  the system, creating, transmitting  and
receiving messages.

Turning the power on/off

Press the [POWER] switch to power or turn off the terminal unit

DISTRESS button

Use  the  [DISTRESS]  button  to  transmit  the  distress  alert  when  there  is  a
life-endangering situation in your ship.
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Floppy disk drive, floppy disks

The  terminal  unit  provides  a  floppy  disk  drive  for  storing  transmitted  and  received
messages on floppy disks. The floppy disks used with the system are 2HD (1.44 MB)
and 2DD (720 KB).

Note:  Vox  Maris  enables  to  work  without  a  floppy.  To  do  this,   run  the
Configurador.exe  application  and  specify  a  Windows  folder  for  storing  messages.
Such folder will act as the root directory of the floppy disk.

Audio alarm

The audio alarm is released in the following instances:

· Telex / e-mail received: Yes

· Distress acknowledge received: Yes

· EGC message received 

Distress:  Yes 
Urgency:  Yes

      Other:  NO

Keyboard

The terminal is almost 100% keyboard controlled. The main keys are the Esc key and
the function keys. The other keys work of way similar to those of a computer. 

Esc: Cancels key input and return to previous display screen

F1: File Menu (processes files)
F2: Edit Menu (provides text editing facilities)
F3: Transmit Menu (transmits messages)
F4: EGC Menu (Sets up EGC message facilities)
F5: Reports Menu (Sets up data/message reporting function)
F6: Memory Menu (Displays sent and received message logs)
F7: Options Menu (Login/Logout and other features)
F8: Setup Menu (Sets up the system)
F9: Position Menu (Enter ship's position manually)
F12: Stop Alarm (Silences audio alarm)

Display indications
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The display is divided in three sections:

A) The working area
B) The function menu area
C) The operating status area

Below are the indications and meanings of the items in parentheses of the illustration
above.

(1) Distress alert information message

No display: (no distress alert)
Sending Distress Alert
Sending Distress Alert Test
Distress Acknowledgement Received
Distress Message Call Activated
Distress Message Call Acknowledged
Distress Button Test Mode

(2) Communication network mode

No display: Normal operation
Restoration Mode (flushing): Problem at NCS
Restoration Mode (Reverse video): Previously designated LES is transmitting
the
NCS common channel signal.
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(3) Terminal unit status

IDLE: Idle (awaiting receiving, awaiting transmitting)
IDLE (PENDING): Awaiting reply from LES
SENDING: Sending
RECEIVING: Receiving
LOGIN: Logged in with NCS
LOGOUT: Logging out with NCS
DISTRESS ALERT: When own vessel is transmitting the distress alert
Data Report: Sending data report
TESTING: Performance Verification (PV) testing
TEST SETUP: Requesting PV testing
SCANNING NCS: scanning
EGC RECEIVER: EGC-only receiver operation
Delivery Status Req.: Transmitting delivery status request
Forced Clearing: Stopping receiving, transmitting, or scanning

(4a) Communication status

CALLING: Now calling
WAITING  FOR  ACKNOWLEDGEMENT:  Waiting  for  acknowledgement  from
LES.
RECEIVING EGC MESSAGE: Now receiving EGC message
WAITING FOR BACKOFF: Waiting to transmit data report
Successful Login: Login was successful
Login failed: Login failed
Successful Logout: Logout was successful
Logout failed: Logout failed
Successful Distress Alert: Distress alert successfully
Distress Alert Failed: Distress alert could not be transmitted.
Successful Forced Clearing: Forced clearing successful
Forced Clearing Failed: Forced clearing unsuccessful
SENDING MESSAGE PACKETS: Sending TX message packets
WAITING  FOR  ACKNOWLEDGEMENT:  Waiting  for  acknowledgement  from
LES
Successful sending to LES: Message successfully sent to LES
Sending message failed: Message could not be sent to LES
Call rejected: LES rejected your message
Call pending: LES temporarily suspending communications
Received Call: Call received from LES
Received Call(ITA2): Call(ITA2) received from LES
RECEIVING MESSAGE PACKETS: Receiving message packets
CLEARING: Clearing TX sequence
Successful receiving: You successfully received message
Receiving failed: You could not receive message
Successful Data Report: Data report successfully sent.
Data Report failure: Data report could not be sent.
PV TEST CALL is rejected: PV test call rejected by NCS
PV TEST CALL is pending: PV test pending by LES
TEST-RECEIVING MESSAGE: Receiving test message from LES
TEST-SENDING MESSAGE: Sending test message to LES
TEST-DISTRESS ALERT: Sending test distress alert to LES
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WAITING FOR ACTIVATION: Waiting start of PV test
WAITING FOR TEST RESULT: Waiting for results of PV test
CLEARING: Clearing PV test
PV TEST is Completed: PV test is completed.
PV TEST Failure: PV test failed.

(4a) Version

Program Version number

(5) Frame synchronization

Blank: Changing channel, or during transmission
SYNC (NCS): Synchronizing with NCS
SYNC (LES): Synchronizing with LES
MES Sig. Ch: Changing MES signaling channel
MES Msg. Ch: Changing MES message channel
UNSYNC: Out of synchronization
Retuning: Synchronizing with NCS or LES

(6) Ocean region receiving

No display: Out of synch with satellite
AOR-W: Atlantic Ocean Region-West
AOR-E: Atlantic Ocean Region-East
IOR: Indian Ocean Region
POR: Pacific Ocean Region

(7) Logging status

LOGOUT: Logged out with ocean region
LOGIN: Logged in with ocean region

(8) Other information

No display: No receive message in memory, or printer is operating.
REC. MESSAGE EXISTS (Reverse video): Displayed when a routine message
has not been printed, or a confidential message is received.
Data Report (Reverse video): When data reporting is activated.
Message Report (Reverse video): Message report setting is activated.

(9) Date and time display

With connection of a  navigator  (internal  GPS navigator  or  external  navigator),
date and time (received from satellite)  are displayed.  Manually  input date  and
time are also displayed.

(10) Ship's position

With connection of a  navigator  (internal  GPS navigator  or  external  navigator),
ships  position  is  displayed  in  latitude  and  longitude  and  updated  every  30
seconds, or manually input position is displayed.
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3 System Initialization

This  chapter  provides  the  information necessary  for  initializing  the  Inmarsat  C  unit.
Once the equipment is initialized, you need do no more than press a few keys to get
fully automatic transmission and reception.

Inmarsat  assigns  an  MES  an  Inmarsat  Mobile  Number  (IMN)  when  it  applies  for
Inmarsat registration. The IMN is necessary to communicate in the Inmarsat system.
It is entered into the terminal during the installation.

3.1 System settings

System setup

The System Setup menu provides a way for input of date, time, operating mode, and
port function.

1. Press the [F8] key to choose the Setup menu.

 
2. Press the [2] key to display the System Setup menu.

 
3.  System Date  & Time is  selected;  press  the  arrow keys to  choose MES Operation
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Mode.

4. Note: Entry of date is not necessary because it is taken from the simulation.
             The IMN is entered during installation. The IMN window cannot be opened.
 
5. Press the [Enter] key to open the MES operation mode options window.

 
6. Choose operating mode, INMARSAT-C or EGC. Press arrow keys to position itself in
the wished option and press Space to select it.

The  INMARSAT-C  setting  provides  Telex  communications  and  operates  as  an  EGC
receiver  when  the  equipment  is  not  transmitting  or  receiving.  The  EGC  setting
enables  EGC-only  operation.  In  this  case,  "Current  State:  EGC  RECEIVER"  appears
(reverse video) at the bottom of the screen.
 
7. Press the [Esc] key to close the window.
 
8. Go to the Nav Port option and press the [Enter] key to open the nav port options
window.

9. Choose the navigator which is interfaced to the terminal and press Space to select
it.

OFF: No navigator interfaced or manual input of position
 
EXT: Choose this setting to use external navigator. 
 
INT: Use the GPS receiver (option) built in the terminal unit.

10. Press the [Esc] key to close the window.

11. Go to Active Port option and press the [Enter] key to open the active port options
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window.

12. Go to the suitable active port and press Space to select it.

INT: Use main terminal unit.
 
ALL:  Use  the  terminal  unit  (PC,  etc.)  connected  to  the  DTE  port  on  the  main
terminal.

13. Press the [Esc] key to close the window.

14. Go to Message Output Port option and press the [Enter] key to open the message
output port options window.

15.  Go  to  the  suitable  unit  where  you  want  to  route  received  messages  and  press
Space to select it.

INT: All received messages are routed to the main terminal.
 
EXT: All received messages are routed to the terminal unit connected to the DTE
port on the main terminal unit.
 
INT+EXT:  All  received  messages  are  routed  to  both  the  main  and  external
terminal units.
 
AUTO: The sub address for the DTE port  is 001. Received messages having the
sub  address  of  001  are  routed  to  the  DTE  terminal.  Messages  having  a  sub
address other than 001 are routed to the main terminal.

16. Press the [Esc] key to close the window.

17. Go to EGC Output Port option and press the [Enter] key to open the EGC output
port options window.
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18.  Go  to  the  suitable  unit  where  you  want  to  route  received  EGC  messages  and
press Space to select it.
 

INT: All received EGC messages are routed to the main terminal.
 
INT+EXT: All received EGC messages are routed to both the main and external
terminal units.

 
19. Press the [Esc] key to close the window.

20. Press the [Esc] key to open the update window.

21. Yes is selected; press the [Enter] key to update system settings.

3.2 Terminal Setup

The Terminal Setup menu enables for selection of date display format, currency unit,
screen saver on/off and window colors.

1. Press the [F8] key to choose the Setup menu.

2. Press the [4] key to display the Terminal Setup screen.
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3. Date Disp. Form is selected; press the [Enter] key to open its options window.

4.  Choose  date  display  format  desired  and  then  press  the  [Enter]  key  to  close  the
window.

5. Go to the Currency Unit choice and press the [Enter] key to open the currency unit
options window.

6. Choose  the currency unit to use to calculate toll charges and press the [Enter] key
to close the window.

7. Go to the Screen Saver option and press the [Enter] key to open the screen saver
options window.

8.  Choose  "ON"  or  "OFF"  as  desired  and  press  the  [Enter]  key.  ON  to  use  screen
saver, OFF to disable the screen saver.  The screen saver automatically  starts up 10
minutes after there is no key operation. To release the screen saver, press any key.

9. Go to the Window Color option and press the [Enter] key to open the window color
options window.
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10.  You  may  change  the  background  and  foreground  colors  for  the  various  display
screens on the terminal unit as follows:

Choose Window Color Setup and press the [Enter] key.

Window is selected; use the  arrows  right  or  left  key to  choose the  item to  adjust
and then press the [Enter] key.

Base Window: Standby display
RCV Message Display: Receive message display
EGC Message Display: EGC message display
Function: Menu
Sub Menu1 – Sub Menu4: Sub menus 1-4
Message: Status message

 
Choose  Fore  Color  option;  use  the  arrows  right  or  left  key  to  choose  foreground
color desired and then press the [Enter] key.

Choose  Back  Color  option;  use the  arrows  right  or  left  key  to  choose  background
color desired and then press the [Enter] key.

Finally, press the [Esc] key to close the Terminal Setup window and to return to the
Setup Menu.

3.3 Login / Logout

Each  time  the  terminal  unit  is  turned  on,  register  your  vessel  with  the  Inmarsat  C
system  to  enable  communications  between  your  vessel  and  an  LES.  This  is  called
login.  The  first  time  you  login  you  must  do  it  manually;  thereafter  is  it  done
automatically, even when you move to another ocean region.

Note that you cannot transmit the distress alert or receive EGC messages unless you
are logged in.

If you will not be using the Inmarsat C unit for a prolonged period, you should logout
from  the  Inmarsat  C  system,  before  turning  off  the  terminal  unit.  The  Inmarsat  C
system will then register you as inactive, notifying anyone trying to call you that you
are  currently  unavailable.  If  you  do not  log  out  before  turning  off  the  power,  some
LESs may attempt to send a message to you. They may charge your correspondent,
even if you don't receive the message.

Login

1. Confirm that "SYNC (NCS)" and "Logout" appears at the bottom of the screen.
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2. Press the [F7] key to display the Options menu.

3. Press the [1] key to display the Login screen.

4. Yes is selected; press the [Enter] key to start login.

5. Login begins and "Login in progress" appears at the screen

6. When login is completed, the messages "Successful Login"  and "LOGIN" appears.
Then, the terminal unit goes into "Idle" status.

7. Press the [Esc] key to close the Options menu.

Logout

1.  Confirm  that  the  terminal  is  "IDLE"  to  logout.  If  not,  wait  until  the  terminal
becomes "idle".

2.  Press  the  [F7]  key  to  display  the  Options  menu  and  then,  press  the  [2]  key  to
display the Logout screen.

4. Yes is selected; press the [Enter] key to start logout.

5. Logout begins and "Logout in progress" appears at the screen

6.  When  logout  is  completed,  the  messages  "Successful  Logout"   and  "LOGOUT"
appears. Then, you cant turn off the terminal.
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3.4 EGC

3.4.1 EGC Services

EGC Overview

The  EGC  (Enhanced  Group  Call)  services  provided  in  the  Inmarsat  C  system  offers
two services: EGC FleetNET and EGC SafetyNET. Basically, EGC enables to broadcast
messages  to  a  specific  group  of  ships,  or  to  all  ships  within  a  defined  geographical
area.

SafetyNET Overview

In 1988 contracting governments to the Safety  of  Life  at  Sea (SOLAS)  Convention,  working with
the  International  Maritime  Organization  (IMO),  incorporated  these  developments  into  the  Global
Maritime Distress and Safety System (GMDSS). 

Among other  things,  the  GMDSS defines  the  means  by  which  shore-based  authorities  broadcast
distress, urgency and safety information to ships. As explained , the GMDSS relies on two forms of
communications technology to broadcast Maritime Safety Information (MSI): 

· NAVTEX, MF terrestrial radio to cover many coastal areas. 

· SafetyNET, using the Inmarsat-C EGC service deals with the distribution of MSI by satellite,
covering entire Inmarsat ocean regions including coastal areas. 

Arrangements for distribution of Maritime Safety Information (MSI) 
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How does SafetyNET work? 

The  SafetyNET  service  provider  determines  which  receivers  are  to  receive  the  message  by
including  identifying  information,  such  as  the  NAVAREA/METAREA/geographical  area  for  which
the MSI is intended. 

In the next figure, the shaded parts represent the EGC SafetyNET service. 
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Operation of the SafetyNET service, below illustrated, involves a sequence of events: 
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· A  registered  Information  Provider,  such  as  a  national  Hydrographic  Office,  Rescue
Co-ordination  Center  (RCC),  or  Meteorological  Office,  receives  information  from  its
specialized sources. 

 

· Each Information Provider prepares an MSI message in a standardized format, and submits it
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to  the  appropriate  co-ordinator  (Navigational  Warning  Co-ordinator,  SAR  Co-ordinator,  or
Meteorological Issuing Service). 

 

· The  co-ordinator  checks  the  message  with  any  other  information  received,  and  edits  it
accordingly, then submits the finalized text to a selected Inmarsat-C CES. Included with the
message are the following codes (known as the "C" codes), to instruct the CES and SES on
how to process the message automatically: 

 

· Priority Code (distress, urgency, safety, or routine); 

· Service  Code,  to  identify  the  message  type,  for  example  a  shore-to-ship  distress
alert, or meteorological forecast; 

· Address Code, to identify the geographical area for which the MSI is applicable - this
may be a fixed geographical area, such as one of the 16 NAVAREAs/METAREAs, or
a temporary area determined by the originator, such as a circular or rectangular area
 

· Repetition Code, to indicate the number of times the message should be broadcast 

· Presentation  Code,  to  indicate  the  character  set  in  which  the  message  will  be
transmitted and printed. (The character set used is always the International Alphabet
Number 5, which is also known as 7-bit ASCII.) 

· The Information Provider may also choose the scheduled time(s) at which the message is to
be  broadcast,  and,  if  a  CES  operates  in  more  than  one  Ocean  Region,  the  satellite  to  be
used. 

 

· The CES receives the message with its instructions, and queues it with any other messages
received, according to priority and scheduled time of transmission. 

 

· At  the  required  time for  transmission,  the  CES  forwards  the  message  over  the  Interstation
Signalling Link (ISL) to the NCS for the Ocean Region. 

 

· The  NCS automatically  broadcasts  the  message  on  the  NCS Common  Signalling  Channel
over the entire Ocean Region. 

 

· All Maritime Inmarsat-C EGC receivers will receive the MSI message, and print it out, unless
the operator has chosen to reject messages of that type, or it has recently been printed out by
that terminal. 

EGC FleetNET Overview

FleetNET is an Inmarsat Enhanced Group Calling (EGC) broadcast facility which allows
a single message to be addressed and transmitted simultaneously to any number of
Inmarsat-C Ship Earth Stations (SESs).

Inmarsat-C  SES  terminal  numbers  are  continue  to  increase  rapidly  even  after  the
implementation date for GMDSS passed on  1st  February  1999.  The requirements  of
Vessel  Monitoring  Systems  (VMS)  for  fisheries  has meant  that  many fishing  vessels
are  also  equipped  with  Inmarsat-C.  All  are  capable  of  receiving  EGC  text  messages
and there is no maximum to the number of vessels that  can be address at  any one
time.  It  is  also  possible,  of  course,  to  send  individual  e-mail  messages  to  single,
specific ships. 

Who can join and use FleetNET services? 

The  FleetNETSM  service  is  available  to  all  authorized  information  providers,  to



System Initialization 25

© 2009    Advenio Software S.R.L.

broadcast  messages  to  selected  groups  of  SESs.  Authorized  information  providers
may  be  commercial  subscription  services,  Government  departments,  shipping
companies, managers, or others who have registered with the LESO and been added
to a FleetNETSM EGC closed network. 

An SES in a closed network may, for example,  belong  to  a  fleet,  or  be  a  registered
subscriber to a commercial service. Typical applications of FleetNETSM include but are
not limited to: 

· Fleet or company broadcasts 

· News broadcasts 

· Commercial weather services 

· Localized medical information 

· Market quotations 

· Commercial messaging / advertising of services 

· Government broadcasts to all vessels on a country's register 

How does FleetNET work? 

To join a FleetNET service, an SES must be registered with an information provider.
Authorized  information  provider  adds  the  SES  to  the  group  which  is  to  receive  the
service,  by  downloading  a  Group  Call  ID  (via  an  LES  which  supports  FleetNETTM
broadcasts),  uniquely  addressed to  the  SES.  The SES stores  the  ID  and  can  accept
broadcasts from the information provider. The SES operator cannot change this stored
EGC  closed  network  IDs  (ENIDs).  Up  to  64  ENIDs  are  stored  on  a  non-volatile
memory.

The ENID stored can be accessed for downloading and deleting via the satellite path.
It is possible for an SES operator to inhibit (or activate as required), via the terminal
unit,  selected  ENIDs  previously  downloaded.  Along  with  the  ENID,  the  name of  the
information provider is stored. 

The pre-programming  of  an  SES to  receive  FleetNET  messages  is  performed  by  the
LESO,  in  conjunction with  the  authorized  FleetNET  information provider,  and  not  by
the SES operator. 

The FleetNET service employs closed user groups and unique receiver  addressing to
provide secure transmission of messages from the terrestrial information provider to
the desired SES recipients. Adding or deleting an SES to a closed user group which is
to  receive  the  broadcasts  is  performed  by  the  LESO,  in  agreement  with  the
information provider. 

The LESO initially downloads an EGC network identification (ENID) code for the closed
user  group,  for  storage  in  the  SES.  Details  on  how  this  is  done  and  all  addressing
information will be provided by any LESO which offers FleetNET services. 

To  select  the  EGC  receivers  that  are  able  to  receive  a  message,  the  information
provider prepares a message which includes an address to specify the area for which
the message is intended. The address may specify any of the following groups: 

· Individual EGC receivers; 
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· All EGC receivers within a closed network; for example all ships belonging

to a fleet, identified by a single EGC Network Identification Code ENID; 
· All EGC receivers on ships of a certain flag. 

Messages sent  using FleetNETSM will  be  received simultaneously  by  all  members of
the  group  defined  by  the  ENID.  The  SES  remains  able  to  accept  all  FleetNETSM
messages  addressed  by  the  information  provider  to  its  user  group,  until  the  SES
ceases  to  subscribe  to  the  service.  The  information  provider  then  cancels  the  ENID
code stored in the SES, through the LESO downloading  a  cancellation  code,  sent  as
above, addressed uniquely to the SES. 

Distribution diagram for Inmarsat-C EGC services 

Note that an SES is not limited to receiving broadcasts from one FleetNET information
provider, but may register with several. 

Note also that the SES operator cannot change this stored information but can inhibit
reception of FleetNET messages, if desired. 

3.4.2 EGC Settings

3.4.2.1 EGC Setup

The Inmarsat C terminal receives EGC messages directed to its present position and



System Initialization 27

© 2009    Advenio Software S.R.L.

Navarea  without  further  programming.  The  EGC  Setup  screen  lets  you  choose
additional areas for which to receive messages and also the Navtex station and type
of message for Coastal Warning (NAVTEX Re-broadcast).

1.  Press  the  [F8]  key  to  display  the  Setup  menu  and  then,  press  the  [5]  key  to
display the EGC Setup menu.

2. The cursor is selecting Additional Position, where you can enter the L/L position of
an ocean region you want to receive broadcasts about. Press the [Enter] key to open
the additional position entry window.

   

3. Enter position as follows:

a) Enter latitude (Example: 37.40S)
b) Enter longitude (Example: 54.35W)

4.  Go  to  the  Additional  Navareas  option  and  press  the  [Enter]  key  to  open  the
Navareas entry window

5. Input the additional Navarea numbers separated by spaces. Example: 1 3 11 14.

6.  Press the [Enter] key to close the Navareas entry window.
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7. Choose Waypoint and press the [Enter] key to open the Waypoint options menu.

8. Go to ON option and press spaces to receive broadcasts for the area which contains
the  destination  waypoint  set  on  the  navigator.  Then,  press  [Esc]  key  to  close  the
Waypoint options window.

9. On the Station Code, press the [Enter] key to open the station code entry window.

10.  Enter  the  Navtex  station  codes  (A-Z)  of  the  navarea,  in  upper  case  alphabet.
(Example: A B F M). After that, press the [Enter] key to close the station code entry
window.

11.  Choose  message  type to  receive:  Use the  arrow  keys  to  choose  message  type,
press the [Space bar] key to choose ON or OFF as appropriate. Finally, press the [Esc]
key to close the window.

Note:  Navtex  messages  "Coastal  navigational  information",  "Meteorological
warning"  and  "Search  and  rescue  alert"  (they  do  not  appear  on  the  EGC  Setup
menu) must always be received.

12. Press the [Esc] key to open the update window.
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13. Yes is selected; press the [Enter] key to update EGC settings.

3.4.2.2 Saving/Printing EGC messages automatically

You may save and print EGC messages automatically as below.

Automatically saving EGC messages

1. Press the [F8] key to display the Setup menu.

2. Press the [6] key to display the Auto Mode Setup menu.

3.  Press  the  arrows  keys  to  choose  Auto  EGC  Message  Save  and  then  press  the
[Enter] key to open the Auto EGC Message Save window.
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4. Press the arrows keys to choose message type and then press the [Enter] key.

5.  Go  to  ON option  or  OFF  option  as  appropriate  and  press  the  [Space  bar]  key  to
select it. Then press the [Esc] key to close the window.

 
Note: When SafetyNET (Safety) is turned off, SafetyNET (Safety) on the Auto EGC
Message Print menu is automatically turned on.

6. Press the [Esc] key to close the Auto EGC Message Save window and to return to
the previous menu

Automatically printing EGC messages

You  can  turn  on/off  automatic  printing  of  FleetNET,  SafetyNET  (Routine)  and
SafetyNET (Safety) messages. Distress and emergency SafetyNET (Safety) messages
are automatically printed regardless of printing setting.

1. Press the [F8] key to display the Setup menu.

2. Press the [6] key to display the Auto mode setup menu.
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3. Go to Auto EGC Message Print option and then press the [Enter] key.

4. On the Auto EGC Message Print window, press the arrows keys to choose message
type and then press the [Enter] key.

5.  Go  to  ON option  or  OFF  option  as  appropriate  and  press  the  [Space  bar]  key  to
select it. Then press the [Esc] key to close the window.

Note:  When SafetyNET  (Safety)  is  turned  off,  SafetyNET  (Safety)  on  the  Auto  EGC
Message Save menu is automatically turned on.

6. Press the [Esc] key to close the Auto EGC Message Print window and to return to
the previous menu

3.5 Directories

The user can create and specify the directory where to save received and sent
messages in a floppy disk. If no directory is made, the messages are saved to the root
directory of the floppy disk.

Note: Vox Maris enables to work without a floppy. To do this,  run the
Configurador.exe application and specify a Window folder for storing messages.
Such folder will act as the root directory of the floppy disk.

Creating a directory where to store messages

The procedure below shows how to create a directory on a floppy disk.
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1. Insert a floppy disk in the disk drive.

2. Press the [F8] key to display the Setup menu.

3. Press the [8] key to display the Directories menu.

4. Choose Message Directory and then press the [Enter] key to open the Directories
window.

5. Press the [Insert] key. After that enter directory name and press the [Enter] key.
Entered name appears.
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Note  1:  To  create  a  directory  within  a  directory,  enter  to  a  directory  and  repeat
step 5.
Note  2:  To  return  to  the  root  directory,  place  the  cursor  on  [.  .]  and  press  the
[Enter] key.
Note 3: Pressing the [Tab] key you access the upon part, where you can create a
new directory, change the current directory, etc. 

6. Press the [Enter] key to select the directory where to store the messages

7. Press the [Esc] key to return to the previous menu

Note 4:  To remove a  directory,  do steps  1-4 in  the  above  procedure,  choose the
directory to remove and then press the [Delete] key.
Note  5:  A  directory  for  EGC  messages  can  also  be  made  as  above.  In  this  case
choose EGC Message Directory at step 4.

Specifying directory where to store messages

You may specify the directory where to store messages on a floppy disk as follows:

1. Press the [F8] and [8] keys to show the Directories menu.

2. Choose Message Directory and press the [Enter] key.
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3. Press the arrows keys to place the cursor on the desired directory.

4. Press the [Enter] key to select the directory where to store the messages

5. Press the [Esc] key to return to the previous menu

Note:  The  directory  where  to  store  EGC  messages  can  also  be  specified.  In  this
case choose EGC Message Directory at step 2.

3.6 Scanning NCS Common Channel

Scanning is possible when the terminal is in idle state and functions as an Inmarsat C
receiver.  If  the  FELCOM  15  is  not  in  idle  state,  it  will  wait  until  the  equipment
becomes idle.

1. Press the [F7] key to display the Options menu.

2. Press the [5] key to display the Ocean Region menu.
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3. Press the arrows keys to choose another NCS and press the [Space Bar] key.

· When  AUTO  is  selected,  the  Unit  explores  each  ocean  region  and  selects  the

region that corresponds to the current position.   

4. Press the [Esc] key to close the window and to start the scanning. The message "
Scanning" appears during the scanning.

· When the process is successfully done, the name of the new NCS appears at the

bottom and the terminal pass to the IDLE status.
· If the Ocean Region selected is not found the below window appears

5. Press the [Esc] key to close the Options menu



File Operations

Chapter IV
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4 File Operations

4.1 Preparing files

4.1.1 Preparing a routine file

Files can be assigned a file name and saved to a floppy disk for later use. A message
may contain maximum 32 Kbytes of characters.

To prepare a routine file, follow the below procedure

1. Press the [F1] key to open the File menu.

 

2.  Press  the  [1]  key  to  choose  New  (if  the  work  area  would  have  a  message,  the
terminal will ask you for saving the message). The work area will show empty.

3. The cursor is on the first line. Type your message.

4.  To  transmit  the  message  you  have just  prepared,  go to  paragraph  "Transmitting
prepared  message".  To  store  it  to  a  floppy  disk,  for  future  transmission,  go  to
paragraph "Saving files".

4.1.2 Working with text

Cutting and pasting text

1. Use the arrow keys to place the cursor on the first character of the text to be cut.

2. Highlight the text to be cut by pressing the arrow keys while pressing and holding
the [Shift] key. The figure below shows the appearance of highlighted text.
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3. Press the [F2] key to choose the Edit menu.

4. Press the [1] key to choose Cut. The highlighted text is cut and the remaining text
is reformatted.

5. To move text to a new location after it has been cut, place the cursor at the exact
position  in  the  message  where  the  cut  text  begins.  When  the  text  cursor  is  placed
correctly, press the [F2] key and then the [3] (Paste) key.

Copying and pasting text

1. Use the arrow keys to place the cursor on the first character of the text to be cut.

2.  Highlight  the  text  to  be  copied  by  pressing  the  arrow  keys  while  pressing  and
holding the [Shift] key. 

3.  Press  the  [F2]  key to  choose the  Edit  menu.  Then   press  the  [2]  key  to  choose
Copy. The  selected text is copied to the clipboard.

4.  Place  the  cursor  at  the  exact  place  on  the  message  where  the  copied  text  is  to
start. When the text  cursor is placed correctly, press the [F2] key and then the  [3]
(Paste) key. The copied text is placed at cursor location.

Select All
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To select the entire current file for cut and/or copy follow the below procedure:

1. Press the [F2] key to choose the Edit menu. 
2. Press the [5] key to choose Select All. 

Searching Text

The Search function lets you search for text in a forward or backward direction.

1. At the Edit menu, press the [6] key to choose Search feature

2. Search word entry window is opened. Type the word to find and press the [Enter]
key. Use the arrow keys to select "Forward" or "Back" search direction and press the
[Enter] key.

3. Choose Yes to start search. The image below will appear.
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4. Choose Next for search the next occurrence of the searched word or Ch.Direct  to
change the search direction.

5. A message shows when there aren't more occurrences of the word in the selected
direction

6. Press the [Esc] key to close the Search window.

Replacing Text

The Replacing function enables you to replace occurrences of a word or phrase with
another word or phrase.

1. At the Edit menu, press the [7] key to choose Replace feature
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2.  At  the  Search Text  field,  input  the  word  or  phrase  to  be  replaced  and  press  the
[Enter] key.

3. At the Replace by field, input the replace word and press the [Enter] key.

4. Specify the search direction.

5. Choose Query or All and then press the [Enter] key.

Query: Stop at each occurrence of word to answer yes or no to replacement.
All: Replace every occurrence of word without stopping to confirm.

6. Choose Yes to start search and replace.
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7.  If  Query  option  was  selected,  the  terminal  ask  you  about  replacing  the  found
occurrence.

8. A message shows when there aren't more occurrences of the word in the selected
direction

9. Press the [Esc] key to close the Replace window.

Time / Position insert

To  insert  the  current  time  and  the  current  position  of  the  ship  in  a  sentence,  just
open the Edit menu and select the option 8.
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The current time and position will be inserted in the text:

4.2 Saving Files

When you have created a message you may wish to save it to a floppy disk, for future
use.  The  system  uses  3  ½  floppy  disks  with  High  Density  (2HD)  or  double  density
(2DD).

4.2.1 Formatting a floppy disk

In order  to  save  a  message  to  a  floppy  disk,  it  must  be  formatted first.  Formatting
prepares the disk to write information to its surface.

1. Insert a blank floppy disk into the disk drive.
2. Press the [F1] key.
3. Press the [8] key (Format Disk).
4. Choose Yes and press the [Enter] key to start formatting.
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4.2.2 Save a file

There are two ways to save a file: Save it without leave the content of the work area
("save"), or save it before clearing the screen editor ("close").

Save file retaining editor screen

1. Press the [F1] key to open the File menu.
2. Press the [4] key to open the Save File window.

3. Enter the file name. The file name must contain up to 8 characters with extension
name (three characters). Colon, quotation mark,space and vertical line are not valid
characters.

4. Press the [Enter] key to save the message.

Note: Pressing the [Tab] key you access the upon part, where you can create a new
directory, change the current directory, etc. 

Save file clearing the editor screen

1. Press the [F1] key to open the File menu.
2. Press the [3] key. The message "Save this message" appears.
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3.  Choose  Yes  and  press  the  [Enter]  key.  The  Save  File  window  appears  on  the
screen.

4. Enter the file name. The file name must contain up to 8 characters with extension
name (three characters). Colon, quotation mark,space and vertical line are not valid
characters.

5. Press the [Enter] key to save the message and clear the screen.

Note: Pressing the [Tab] key you access the upon part, where you can create a new
directory, change the current directory, etc. 

4.3 Opening Files

1. Insert the floppy disk containing the desired file.

2. Press the [F1] key to open the File menu.

3.  Press  the  [2]  key  to  show  the  Open  File  window.  This  window  displays  the  files
stored in the floppy disk.
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4.  Press  the  arrow  keys  to  choose  the  file  (you  can  view  the  content  file  before
opening by pressing the [Space bar] key).

5. Press the [Enter] key to open the file. The file name and the content of the file will
appear at the screen.

4.4 Deleting files

1. Insert the floppy disk containing the file to delete.

2. Press the [F1] key to open the File menu.

3. Press the [5]  key to show the  Delete  File  window.  This  window displays  the  files
stored in the floppy disk.
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4.  Press  the  arrow  keys  to  choose  the  file  you  want  to  delete  (you  can  view  the
content file before deleting by pressing the [Space bar] key).

5. Press the [Enter] key to delete the file. The message "Delete file ..." appears.

6. Choose Yes and press the [Enter] key to delete the file.
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4.5 Renaming files

1. Insert the floppy disk containing the file to rename.

2. Press the [F1] key to open the File menu.

3. Press the [6] key to show the Rename File window. This window displays the files
stored in the floppy disk.

4. Press the arrow keys to choose the file you want to rename (you can view the
content file before renaming by pressing the [Space bar] key).

5. Press the [Enter] key to rename the file. The window to entry the new name
appears.
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6. Enter the new file name. The file name must contain up to 8 characters with
extension name (three characters). Colon, quotation mark,space and vertical line are
not valid characters.

7. Press the [Enter] key to rename the file.



Communications

Chapter V
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5 Communications

This  chapter  explains  how  to  transmit  and  receive.  Before  conducting  any
communications, be sure to login with the NCS in your area, following the instructions
in "System Initialization - Scanning NCS Common Channel"

To transmit e-mail, you may need to register for e-mail services with appropriate LES
which provides such services. Further, it is necessary to register with appropriate LES
to receive e-mail from land mail system.

5.1 Transmitting

Basically, to transmit a message, the user have to accomplish the following steps:

1. Creating the message
2. Attaching the address of the recipient.
3. Sending the message to the LES. 

The  address  of  the  recipient  in  the  Inmarsat  C  system  is  his  Telex  number,  for
transmission via landline, or MES Inmarsat Mobile Number (IMN), when transmitting
to a ship. Also, mails and faxes can be sent.

The message can be one the user has just prepared or one stored on a floppy disk.

Code description

Code can be specified at the terminal unit.

IA5:  International  alphabet  No.  5,  ASCII  code  (7  bit).  Specify  this  code  to
transmit English containing lower case alphabet.

ITA2: No. 2 international communications alphabet (5 bit). Specify this code for
message  which  contains  only  No.  2  international  communications  alphabet  (see
A-11).  ITA2  code  is  transmitted  faster  than  IA5  code.  Land-based  Telex
equipment uses ITA2. The LES converts all codes into ITA2. Code which cannot be
converted is shown with the question mark (?).

DATA: Data (8 bit). Use this code to transmit data.

Message language, subscriber, destination type and code
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5.1.1 Transmitting prepared message

This section explains how to transmit a prepared message (non stored message).

5.1.1.1 Transmitting to a registered station on station list

1.  Write  the  message  on  the  screen.  For  e-mail,  set  Text  Mode  in  the  Editor  Setup
menu to Ascii.

2. Press the [F3] key to display the Transmit menu.

3.  Display the Transmit Message window by selecting the  Transmit  Message option
and pressing [Enter], or by pressing the [1] key.
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4. Go to Station List option and press the [Enter] key to open the Station List

5.  Press  the  arrow keys to  choose the  station  and  then press  the  [Space  Bar]  key.
You can choose multiple stations* (simultaneous transmission) by pressing the Space
bar at the desired stations. Selected stations are marked with an asterisk. 

Note 1: Messages having different communication format or prefix code (two-digit
code) cannot be sent simultaneously.

Note 2: To cancel  selection (erase asterisk),  choose station and press  the  [Space
bar] key.

For e-mail messages, follow the below procedures. For Fax or Telex, go to step 6.
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Procedures for e-mail message

a.  Go  to  the  Subject  field  and  press  the  [Enter]  key  to  open  the  subject  entry
window.
b. Type subject and press the [Enter] key to close the window.
c. Note: Attaching files isn't enable in Vox Maris
d. Continue in step 6.

6.  Go  to  LES  Id  option  and  press  the  [Enter]  key  to  open  the  LES  list  window.  An
asterisk determines the selected LES.

7. If you want to change the selected LES, use the arrow keys to select the suitable
LES and press the [Space bar] key. 

8. Press the [Esc] key to close the LES list.

9. Select Confirmation and press the [Enter] key to open the confirmation window

10. Use the left or right arrow key to select YES if you request notification of delivery
from the LES

11. Press the [Enter] key to close the window.

12.  Choose  Send  Delay  and  press  the  [Enter]  key  to  open  the  send  delay  entry
window.
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13. To send a message after a certain delay, enter a time up to 99 hours 59 minutes.
(The Send Delay is used to time message arrival to suit recipient's office hours.)

14. Press the [Enter] key to close the window.

15.  Choose  Delivery  Delay  and  press  the  [Enter]  key  to  open  the  delivery  delay
options window.

16.  Delivery  Delay  requests  the  LES  for  "Immediate"  or  "Deferred"  transmission  to
the  recipient  designated.  (This  service  depends  of  the  LES  where  message  is  to  be
sent).

17. Press the [Enter] key to close the window.

18. Go to Code option and press the [Enter] key to open the code window.

19.  Press the [Space bar] key to select  an option as appropriate:  "IA5 (for  e-mail,
fax) ", "ITA2 (for Telex)" or "DATA".

20. Press the [Esc] key to close the window.

21. Press the arrow key to place the cursor on TRANSMIT.

22. Press the [Enter] key to open the start transmission window.

23. Choose YES and press the [Enter] key to start the transmission
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24. A window displays sending progress.

5.1.1.2 Transmitting to a not registered station on station list

1.  Write  the  message  on  the  screen.  For  e-mail,  set  Text  Mode  in  the  Editor  Setup
menu to Ascii.

2. Press the [F3] key to display the Transmit menu.

3.  Display the Transmit Message window by selecting the  Transmit  Message option
and pressing [Enter], or by pressing the [1] key.

4.  Go to Destination Type option and  press  the  [Enter]  key to  open the  destination
types window
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5. Press the arrow keys to choose Destination Type among "TELEX," "FAX" or "E-mail"
as appropriate and press the [Enter] key to close the window.

Continue the procedure according to the selected destination type.

Procedures for TELEX message

a.  Go  to  Country/Ocean  Code  option  and  press  the  [Enter]  key  to  open  the
country/ocean code entry window.

For  ship-to-shore Telex, enter recipient's Telex country code.  For ship-to-ship Telex,
enter recipient's ocean region:

Ocean Region Code
AOR-East:  581
POR:  582
IOR:  583
AOR-West:  584

b. Choose Station ID and press the [Enter] key to open the station ID entry window

c.  Type  either  recipient's  Telex  subscriber  number  (ship-to-shore)  or  IMN
(ship-to-ship). You can specify many station IDs delimiting them by commas. 

d.  Go  to  LES  Id  option  and  press  the  [Enter]  key  to  open  the  LES  list  window.  An
asterisk determines the selected LES.
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e. If you want to change the selected LES, use the arrow keys to select the suitable
LES and press the [Space bar] key. 

f. Press the [Esc] key to close the LES list.

g. Select Confirmation and press the [Enter] key to open the confirmation window

h. Use the left or right arrow key to select YES if you request notification of delivery
from the LES

i. Press the [Enter] key to close the window.

j. Choose Send Delay and press the [Enter] key to open the send delay entry window.

k. To send a message after a certain delay, enter a time up to 99 hours 59 minutes.
(The Send Delay is used to time message arrival to suit recipient's office hours.)

l. Press the [Enter] key to close the window.

m.  Choose  Delivery  Delay  and  press  the  [Enter]  key  to  open  the  delivery  delay
options window.
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n. Delivery Delay requests the LES for "Immediate" or "Deferred" transmission to the
recipient designated. (This service depends of the LES where message is to be sent).

o. Press the [Enter] key to close the window.

p. Go to Code option and press the [Enter] key to open the code window.

q. Press the [Space bar] key to select an option as appropriate:  "IA5 (for e-mail, fax)
", "ITA2 (for Telex)" or "DATA".

r. Press the [Esc] key to close the window.

s. Press the arrow key to place the cursor on TRANSMIT.

t. Press the [Enter] key to open the start transmission window.

u. Choose YES and press the [Enter] key to start the transmission

v. A window displays sending progress.

Procedures for FAX message
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a.  Go  to  Country/Ocean  Code  option  and  press  the  [Enter]  key  to  open  the
country/ocean code entry window.

Enter recipient's FAX country code and press the [Enter] key to close this window.

b. Choose Station ID and press the [Enter] key to open the station ID entry window

c. Type either recipient's fax number. You can specify many fax numbers delimiting
them by commas. 

d.  Press the arrow key to choose Modem Type.  Then  press  the  [Enter]  key to  open
the Modem Type entry windows. An asterisk determines the selected option.

e. If you want to change the selected option, use the arrow keys to select the suitable
modem type  and  press  the  [Space  bar]  key.  For  transmission  to  landline  fax  or  to
fax-equipped Inmarsat B MES, choose "T30." (You cannot transmit a FAX to another
Inmarsat C MES.)

f. Press the [Esc] key to close the Modem Type list.

g.  Go  to  LES  Id  option  and  press  the  [Enter]  key  to  open  the  LES  list  window.  An
asterisk determines the selected LES.
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h. If you want to change the selected LES, use the arrow keys to select the suitable
LES and press the [Space bar] key. 

i. Press the [Esc] key to close the LES list.

j. Select Confirmation and press the [Enter] key to open the confirmation window

k. Use the left or right arrow key to select YES if you request notification of delivery
from the LES. After that, press the [Enter] key to close the window.

l. Choose Send Delay and press the [Enter] key to open the send delay entry window.

m. To send a message after a certain delay, enter a time up to 99 hours 59 minutes.
(The  Send  Delay  is  used  to  time  message  arrival  to  suit  recipient's  office  hours.).
Then, press the [Enter] key to close the window.

n. Choose Delivery Delay and press the [Enter] key to open the delivery delay options
window.
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o. Delivery Delay requests the LES for "Immediate" or "Deferred" transmission to the
recipient designated. (This service depends of the LES where message is to be sent).
If you want to change the selected Delivery Delay, use the arrow keys to select  the
suitable option and press the [Space bar] key. Then, press the [Scape] key to close
the window.

p. Go to Code option and press the [Enter] key to open the code window.

q. Press the [Space bar] key to select an option as appropriate:  "IA5 (for e-mail, fax)
", "ITA2 (for Telex)" or "DATA".

r. Press the [Esc] key to close the window.

s. Press the arrow key to place the cursor on TRANSMIT.

t. Press the [Enter] key to open the start transmission window.

u. Choose YES and press the [Enter] key to start the transmission

v. A window displays sending progress.

Procedures for E-mail message
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a. Choose Station ID and press the [Enter] key to open the station ID entry window

b.  Type recipient's e-mail  address (you can specify many addresses delimiting them
by commas). Then, press the [Enter] key to close the station ID entry window.

c. Go to Subject option and press the [Enter] key to open the Subject entry window.

d.  Type  the  subject's  mail  and  press  the  [Enter]  key  to  close  the  subject  entry
window.

e.  Go  to  LES  Id  option  and  press  the  [Enter]  key  to  open  the  LES  list  window.  An
asterisk determines the selected LES.

f. If you want to change the selected LES, use the arrow keys to select  the suitable
LES and press the [Space bar] key. 

g. Press the [Esc] key to close the LES list.

h. Select Confirmation and press the [Enter] key to open the confirmation window
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i.  Use the left or right arrow key to select YES if you request notification of delivery
from the LES. After that, press the [Enter] key to close the window.

j. Choose Send Delay and press the [Enter] key to open the send delay entry window.

k. To send a message after a certain delay, enter a time up to 99 hours 59 minutes.
(The  Send  Delay  is  used  to  time  message  arrival  to  suit  recipient's  office  hours.).
Then, press the [Enter] key to close the window.

l. Choose Delivery Delay and press the [Enter] key to open the delivery delay options
window.

m. Delivery Delay requests the LES for "Immediate" or "Deferred" transmission to the
recipient designated. (This service depends of the LES where message is to be sent).
If you want to change the selected Delivery Delay, use the arrow keys to select  the
suitable option and press the [Space bar] key. Then, press the [Scape] key to close
the window.

n. Go to Code option and press the [Enter] key to open the code window.

o. Press the [Space bar] key to select an option as appropriate:  "IA5 (for e-mail, fax)
", "ITA2 (for Telex)" or "DATA".

p. Press the [Esc] key to close the window.

q. Press the arrow key to place the cursor on TRANSMIT.
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r. Press the [Enter] key to open the start transmission window.

s. Choose YES and press the [Enter] key to start the transmission

t. A window displays sending progress.

5.1.2 Transmitting a file stored on a floppy disk

This section explains how to transmit a message from a file.

1. Press the [F1] key to open the File menu.

2. Press the [2] key to show the Open File dialog.
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3. Press the arrow keys to change to the suitable file and press [Enter] to open it. The
file is displayed on the work area.

4. To transmit the message, follow the steps described on any of the previous topic:

· Transmitting to a registered station on station list

· Transmitting to a not registered station  on station list
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5.2 Receiving

Each time the terminal receives a Telex or e-mail it displays the message "Successful
Receiving message." If Auto Receive Message Save and Auto Receive Message Print in
the Auto Mode Setup are set to ON, the message is automatically saved and printed.

Received message alarm

If Receive Alarm in the Auto Mode Setup menu is set to ON, the audio sounds when a
Telex or e-mail is received. You may silence the alarm with the [F12] key.

Receive message

Each  message  received  is  assigned  a  message  number.  This  number  is  also  used
when saving the file to a floppy disk. The number's structure is:

  R 0 0 7 0 1     1 8. 0 0 1

  Receive 0: main DTE year month     day receive message number

1: ext. DTE

Log

The  Log  (described  below)  shows  message  number,  priority,  date  and  time  of  
transmission,  LES  ID  and  file  size  (in  bytes)  of  the  received  and  transmitted
messages.

Printing

When  Auto  Receive  Message  Print  in  the  Auto  Mode  Setup  menu  is  set  for  ON,
received messages are automatically printed. Manual printing is also available.

Saving and filing

Received messages are filed in the Display Message List, at the terminal unit specified
with  Message  Output  Port  on  the  System  Setup  menu.  The  Display  Message  List
shows the following:

Received message number.
LES ID
Priority
File size (in bytes)
Message classification
Date and time of transmission
Status

Setting the receive alarm
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An audio alarm may be set to sound when a routine or confidential Telex message or
e-mail is received. The default setting is OFF.

1. Press the [F8] key to display the Setup menu.

2. Press the [6] key to display the Auto Mode Setup menu.

3. Press the arrow keys to choose Receive Alarm and press the [Enter]  key to open
the receive alarm options window.

4.  To  enable  the  audio  alarm,  choose  ON  going  to  the  ON  option  and  pressing  the
[Space]  key.  Then,  press  the  [Esc]  key  to  close  the  window.  The  alarm  will  be
released when a routine message is received.
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4. Press the [Esc] key to close the Auto Mode Setup window.

Displaying received messages

Received messages are automatically printed when the Auto Receive Message Print is
ON in the Auto Mode Setup. To see a received message follow the procedure below.

1. Press the [F6] key to open the Memory menu.

2. Press the [2] key to display the list of received messages.

Message Nº: Received message number.
LES: LES name
Priority: Normal or distress
Size: Size of file in bytes
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Addressee: Addressee code appears for confidential messages (Not implemented in
Vox Maris). Nothing appears for routine messages.
Rec date & time: Date and time message was received.
Status:  Printed:  message  printed  //  Saved:  message  saved  to  floppy  disk  //  No
display: not yet printed confidential message, or printer malfunction

3.  Press the arrow keys to choose a  file.  To  display  a  file  selected,  press  the  space
bar. 

4. Press the [Esc] key to close the view file window.

Automatically printing received messages

1. Press the [F8] key to display the Setup menu.

2. Press the [6] key to display the Auto Mode Setup menu.



Communications 71

© 2009    Advenio Software S.R.L.

3.  Press  the  arrows  keys to  choose Auto  Receive Message Print  and  then press  the
[Enter] key to open the Auto Receive Message Print window.

4.  Go  to  ON option  or  OFF  option  as  appropriate  and  press  the  [Space  bar]  key  to
select it. Then press the [Esc] key to close the window.

 
5. Press the [Esc] key to close the Auto Receive Message Print window and to return
to the previous menu

Automatically saving received messages to a floppy disk

1. Press the [F8] key to display the Setup menu.

2. Press the [6] key to display the Auto Mode Setup menu.
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3.  Press the arrows keys to  choose Auto  Receive Message Save  and  then press  the
[Enter] key to open the Auto Receive Message Save window.

4.  Go  to  ON option  or  OFF  option  as  appropriate  and  press  the  [Space  bar]  key  to
select it. Then press the [Esc] key to close the window.
 
5. Press the [Esc] key to close the Auto Receive Message Save window and to return
to the previous menu

Note:  To  designate  a  directory  where  to  store  receive  messages,  see  Specifying
directory where to store messages 

5.3 Log

The Log stores the details of the received and transmitted messages.

Displaying the display log

1. Press the [F6] key to display the Memory menu.
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2. Press the [4] key to show the Display Memory.

S/R S: Send message // R: Received message
Message Nº: Message no. or file name
Type: Message type (Telex, e-mail, etc.)
Pri: Priority; Normal or Distress
Date: Date message was received (transmitted).
Time: Time message was received (transmitted).
LES: ID of LES which handled the message
Station:  Transmitting  station  name.  Blank  for  unregistered  station  or  received
message.
Size: Size of message in bytes
Cond: Transmission results: Blank if  a received message //  Success:  Successful
transmission // Fail: Failed transmission // Rejected: Message rejected by LES

3. To scroll the Display Log screen, press the arrow keys.  You can see the message
content by pressing the [Space bar] key.
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4. Press the [Esc] key to close the view message window.

5.4 EGC Messages

When an EGC message is received, RECEIVING EGC MESSAGE appears at the bottom
left corner of the display. If Auto Message Save in the Auto Mode Setup is ON, EGC
messages  are  automatically  printed.  EGC  messages  are  automatically  received,
printed and saved to the terminal unit selected with EGC Output Port on the System
Setup menu. 

Displaying EGC messages - EGC Message Memory

1. Press the [F4] key.

2. On Display EGC Message option press the [Enter] key to display the latest received
EGC message.
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3. Press the [Esc] key to close the Display EGC Message window.

You can also follow the below procedure to view the EGC Message Log:

1. Press the [F6] key to display the Memory menu.

2. Press the [3] key to show the EGC Message Log
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Memory.

3. To scroll the EGC Message Log screen, press the arrow keys. You can see the
message content by pressing the [Space bar] key.

Receiving EGC distress or urgent message

When the terminal receives an EGC distress or an urgent  message, the audio alarm
sounds. To silence the alarm, press the  [F12] (StopAlarm) key on the terminal unit.



Distress Operations

Chapter VI
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6 Distress Operations

6.1 Transmitting the Distress Alert

Set the LES where to send the distress alert, following the next procedure:

a. Press the [F8] key to display the Setup menu.

b. Press the [1] key to display the Distress Alert Setup screen. 

c. Press the [Enter] key to display the LES ID list. Press arrows keys to choose a
suitable LES and then press the [Enter] key.



Distress Operations 79

© 2009    Advenio Software S.R.L.

d. Press the [Esc] key to close the Distress Alert Setup window.

When a life-endangering situation arises on your vessel and you do not have the time
to specify the nature of distress, do the following to transmit the distress alert to an
LES.

1. Open the cover of the [DISTRESS] button on the terminal unit.
 

2. Press the [DISTRESS] button about five seconds.

The distress alert will not be transmitted until the audio alarm sounds. The message
"Sending Distress Alert" appears on the screen while the distress alert is being
transmitted.

When you receive acknowledgment of the distress alert from an LES, the message
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"Distress Acknowledgement Received" appears on the screen, the lamp in the
[DISTRESS] button flashes slowly and the audio alarm sounds intermittently. To
silence the audio alarm, press the [F12] key on the keyboard.

Note: The [DISTRESS] button on the terminal cannot be used to silence the audio
alarm for incoming distress or EGC urgency broadcast. The [DISTRESS] button is for
transmitting distress alert for own ship. It cannot be used to silence the audio alarm.
Use the [F12] key to silence the audio alarm.

6.2 Specifying Distress Nature

When a life-endangering situation arises on your vessel  and there is time to specify
nature of distress and recipient (LES) of distress alert  send own ship data (position,
time, speed and course) as follows:

1. Press the [F8] key to display the Setup menu.

2. Press the [1] key to display the Distress Alert Setup screen.

LES ID

3. Press the [Enter] key to display the LES ID list. Press the arrow keys to choose a
suitable LES and then press the [Enter] key.
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4. Choose Date / Time and then press the [Enter] key.

5. Enter date and time and then press the [Enter] key.

6. Choose LATITUDE and then press the [Enter] key.

7. Enter position in latitude. Enter co-ordinate with appropriate alphabet key N or S

8. Choose LONGITUDE and then press the [Enter] key.

9. Enter position in longitude. Enter co-ordinate with appropriate alphabet key E or W.

10. Press the [Enter] key to close the window.

Note: The menu item Protocol is fixed at Maritime.
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11. Choose Nature and press the [Enter] key to display the Nature of Distress list and
then  choose  appropriate  nature  of  distress.  If  nature  of  distress  is  not  specified,
"Undesignated" is automatically selected

Press the arrow keys to choose the desired distress nature and press the [Space Bar]
key to select it.

12. Press the [Esc] key to close the list.

13. Choose Course and then press the [Enter] key.

14. Enter course and then press the [Enter] key to close the window.

15. Go to Speed choice and then press the [Enter] key.

16. Enter speed and then press the [Enter] key to close the window.

17. Press the [Esc] key to close the Distress Alert Setup screen.

18. Open the cover of the [DISTRESS] button on the terminal unit.
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19. Press the [DISTRESS] button about five seconds.

The distress alert will not be transmitted until the audio alarm sounds. The message
"Sending  Distress  Alert"  appears  on  the  screen  while  the  distress  alert  is  being
transmitted.

When you receive acknowledgment of the distress alert from an LES, the message
"Distress  Acknowledgement  Received"  appears  on  the  screen,  the  lamp  in  the
[DISTRESS]  button  flashes  slowly  and  the  audio  alarm  sounds  intermittently.  To
silence the audio alarm, press the [F12] key on the keyboard.

Note: The [DISTRESS] button on the terminal cannot be used to silence the audio
alarm for  incoming distress  or  EGC urgency  broadcast.  The  [DISTRESS]  button  is
for transmitting distress alert for own ship. It  cannot be used to silence the audio
alarm. Use the [F12] key to silence the audio alarm.

6.3 Distress Message

The distress alert provides the minimum distress information: own vessel's ID, speed,
course,  position  and  nature  of  distress.  After  receiving  the  distress  alert
acknowledgment  from  an  LES  and  you  are  not  pressed  for  time,  you  may  send  a
distress message as below to provide more detailed information.

1. Press the [F1] key followed by the [1] key to display the editor screen.

2. Type distress message. For example:

MAYDAY MAYDAY MAYDAY
THIS IS...................................(Ship's name)
I NEED HELP:                 (Type of assistance required)

3.  Press  the  [F3]  key  and  the  [1]  key  to  choose  Transmit  Message.  The  following
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screen should appear.

4. Priority is selected; press the [Enter] key to open the priority options window.

5. Use the arrow key to choose DISTRESS and press the [Space bar] key to select the
priority. Then, press the [Esc] key to close the window.

6. Choose LES ID and press the [Enter] key to open the LES list.
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7. Go to the LES where the distress message is to be transmitted, preferably the one
where the distress alert was transmitted. 
Press the [Space bar] key to select the LES and press the [Esc] key to close the LES
list window.

8. Press the arrow keys to place the cursor on TRANSMIT and press the [Enter] key.

9. Select YES and press the [Enter] key to transmit the distress message to the LES.

The message "Distress Message Call Activated." appears (in red) while the distress
message is being transmitted. When you receive acknowledgment from an LES, the
message "Distress Message Call Acknowledged." appears.

Note: Country/Ocean Code and Station ID are not required in a distress message.

6.4 Testing the Distress button

The  [DISTRESS]  button  on  the  terminal  unit  may  be  tested  as  below  without
transmitting the distress signal. Note
that the distress alert cannot be transmitted while testing the [DISTRESS] button.

1. Press the [F7] key to display the Options menu.

2. Press the [7] key to display the Test menu

3. Press the [4] key to display the Test menu. Select Yes option and press the [Enter]
key to start the test. A message shows that the button distress is under test mode. 

4. Open the [DISTRESS] button cover and press the [DISTRESS] button five seconds.
The  message  "Distress  Button  works  correctly."  appears  if  the  button  is  working
properly.
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5. Close the [DISTRESS] button cover.

6. To escape from the test, press the [Esc] key on the keyboard of the terminal unit
twice.  The  test  mode  stops  and  a  message  appears  to  notifying  you  that  normal
operation has been restored.
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